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This equipment has been tested and 
found to comply with the limits for a 
Class A digital device, pursuant to part 
15 of the FCC Rules. These limits are 
designed to provide reasonable 
protection against harmful interference 
when the equipment is operated in a 
commercial environment. This 
equipment generates, uses, and can 
radiate radio frequency energy and, if 
not installed and used in accordance 
with the instruction manual, may cause 
harmful interference to radio 
communications. 

You are cautioned that any changes or 
modifications not expressly approved by 
the party responsible for compliance 
could void the user's authority to 
operate the equipment. 



BusSecure WaveReader User Manual  
 

 

0150-0266B  / March 2004 3 

TABLE OF CONTENTS 
BEFORE YOU BEGIN ..........................................................................................................5 

1 OVERVIEW................................................................................................................6 
1.1 About this Manual....................................................................................................................6 
1.2 Introduction..............................................................................................................................6 
1.3 Product Description.................................................................................................................7 
1.4 Features ...................................................................................................................................8 
1.5 Hardware System Requirements.............................................................................................8 

2 GETTING STARTED....................................................................................................9 
2.1 Operator Information ...............................................................................................................9 
2.2 Installation................................................................................................................................9 

2.2.1 Installing From CD-ROM.....................................................................................................9 
2.3 Starting the BusSecure  WaveReader software .....................................................................9 

2.3.1 Connecting to a Site/Device via the Address Book ............................................................11 
2.4 Retrieving Video from a BusSecure DVR..............................................................................12 
2.5 Opening a Saved Video File ..................................................................................................13 

2.5.1 Printing from the Image Log Window.................................................................................14 

3 BUSSECURE WAVEREADER REFERENCE..................................................................16 
3.1 WaveReader Main Window Overview ...................................................................................16 
3.2 The Main Program Window ...................................................................................................17 

3.2.1 The Menu Bar...................................................................................................................17 
3.2.2 The Icon Bar .....................................................................................................................17 
3.2.3 The Main Viewing Area .....................................................................................................18 
3.2.3.1 Enhancement Pop-up Menu ..........................................................................................18 
3.2.4 The Status Bar..................................................................................................................18 
3.2.5 The Button Panel ..............................................................................................................19 

3.3 The File Menu.........................................................................................................................19 
3.3.1 Open ................................................................................................................................19 
3.3.2 Save Image ......................................................................................................................20 
3.3.3 Print Image .......................................................................................................................20 
3.3.4 Log In ...............................................................................................................................20 
3.3.5 Get Complete Log File ......................................................................................................20 
3.3.6 Get Log File......................................................................................................................21 
3.3.7 Exit ...................................................................................................................................21 

3.4 The View Menu.......................................................................................................................21 
3.4.1 The Disk Analysis Screen .................................................................................................21 
3.4.2 The Image Log..................................................................................................................22 
3.4.3 Ways to select Images......................................................................................................22 

3.5 The Setup Menu.....................................................................................................................23 
3.5.1 The Address Book ............................................................................................................24 
3.5.1.1 Connecting to a Site/Device via the Address Book.........................................................24 
3.5.1.2 Editing the Address Book ..............................................................................................25 

3.6 The Security Menus...............................................................................................................25 
3.6.1 Security Shell Overview ....................................................................................................25 
3.6.1.1 Using the Security database from multiple computers. ...................................................26 
3.6.1.2 Additional Notes. ...........................................................................................................26 

3.7 Security Menus ......................................................................................................................27 
3.7.1 Change Password.............................................................................................................27 
3.7.2 View User Rights ..............................................................................................................27 
3.7.3 Site Administration ............................................................................................................28 



 BusSecure WaveReader User Manual  
  

4 0150-0266B  / March 2004 

3.7.3.1 Creating the Site Address Book .....................................................................................28 
3.7.3.2 Importing an Address Book (from versions of WaveReader earlier than 2.5) ..................28 
3.7.3.3 Creating an Address File (for basic information).............................................................29 
3.7.4 Group Administration ........................................................................................................29 
3.7.4.1 Access Levels ...............................................................................................................30 
3.7.5 User Administration...........................................................................................................30 
3.7.6 Unit Type Setup ................................................................................................................30 
3.7.7 Custom Caption Setup......................................................................................................30 

3.8 Connection Type Setup Menu...............................................................................................31 
3.8.1 Normal Connections..........................................................................................................31 
3.8.1.1 Playback Mode..............................................................................................................31 
3.8.1.2 Live Mode .....................................................................................................................31 
3.8.1.3 Entering the Live Mode..................................................................................................32 
3.8.1.4 Leaving Live Mode ........................................................................................................32 
3.8.2 Live Connections ..............................................................................................................32 

3.9 BusSecure Menus..................................................................................................................33 
3.9.1 Version Info ......................................................................................................................33 
3.9.2 Configuration Setup ..........................................................................................................33 
3.9.2.1 Auto Record after Connect ............................................................................................34 
3.9.2.2 Use MV Address List .....................................................................................................34 
3.9.2.3 The Action List ..............................................................................................................34 
3.9.3 Audio Menu ......................................................................................................................34 

3.10 The Search Menu................................................................................................................35 
3.10.1 Basic Mode.......................................................................................................................35 
3.10.2 Advanced Mode................................................................................................................37 
3.10.3 Search Results .................................................................................................................37 

3.11 The Help Menu....................................................................................................................37 
3.11.1 Help Topics.......................................................................................................................37 
3.11.2 About ................................................................................................................................38 

4 WAVESTUDIO .........................................................................................................39 
4.1 Opening WaveStudio.............................................................................................................39 
4.2 WaveStudio Toolbar ..............................................................................................................39 
4.3 WaveStudio Main Viewing Area ............................................................................................40 
4.4 Opening a File in WaveStudio...............................................................................................40 

5 QUICKWAVE EVIDENCE CAPTURE CD......................................................................41 
5.1 Creating The QuickWave CD.................................................................................................41 
5.2 Playing The QuickWave CD...................................................................................................41 

WARRANTY AND RETURN INFORMATION ............................................................................42 
Advance Replacement Policy..........................................................................................................42 

 



BusSecure WaveReader User Manual  
 

 

0150-0266B  / March 2004 5 

BEFORE YOU BEGIN 

Read these instructions before installing or operating this product. 

This manual provides installation and operation information. To use this document, you must have the 
following minimum qualifications: 

� A basic knowledge of CCTV systems and components 

� A basic knowledge of electrical wiring and low-voltage electrical hookups 

Intended use 

Use this product only for the purpose for which it was designed; refer to the product specification and user 
documentation. 

Customer Support 

For assistance in installing, operating, maintaining, and troubleshooting this product, refer to this 
document and any other documentation provided. If you still have questions, please contact GE Security 
Technical Support and Sales: 

 GE Interlogix, Inc. 
 Call: 800-469-1676 
 Fax: 541-752-9096 

You should be at the equipment and ready with details before calling Technical Support. 

Conventions Used in this Manual 

Boldface or button icons highlight command entries. The following CAUTION, and Note statements 
identify potential hazards that can occur if the equipment is handled improperly: 

 

Caution messages alert the user to a specific procedure which if not followed correctly, 
could cause damage to the equipment and/or serious injury.  

 

 

Notes contain important information about a product, process, or procedure. We 
recommend that you read this manual thoroughly before using the BusSecure 
WaveReader Software. 

 

 

NOTE
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1 OVERVIEW 
 

1.1 ABOUT THIS MANUAL 
This manual is intended to provide the user with the information necessary to successfully install and 
use the BusSecure WaveReader software. It also provides the user with a technical reference for 
performing non-routine tasks. The manual is set up in sections to make the information easy to find. 
 
Section One is an introduction, intended to familiarize the user with the concept of the Digital Video 
Recorder (DVR). In addition, it introduces the BusSecure WaveReader software. 
 
Section Two is a step-by-step guide through the Installation and Setup of the BusSecure 
WaveReader software. In addition, basic operations are covered such as connecting to the Docking 
Station or remote vehicle, and retrieving previously recorded video images. 
 
Section Three is the reference section and is intended to provide the user with a thorough description 
of each screen, menu, and operational details. 
 
Section Four provides information about using the WaveStudio Image Editor. 
 
Section Five provides information about using the QuickWave CD Writer. 
 
 
 
 
 

1.2 INTRODUCTION 
GE Security’s BusSecure is a digital video capture/storage/transmission system that is designed for 
vehicle-based platforms. The typical BusSecure system consists of CCTV cameras, a removable 
digital video recorder (DVR), a Central Station PC with Docking Station, and an optional cellular 
telephone transmission system. The video images are captured at predetermined intervals and/or 
activated by specific triggers, such as a panic button or an inertia switch.  
 
The images, which are stored on the removable DVR, can be downloaded via the Docking Station, 
Ethernet connection or transmitted to a central station through the use of digital cellular 
communications. The system may also be programmed to automatically capture and send images to a 
central station when a previously specified device is activated. 
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Digital Video Recorder Storage Device (DVR) 

The DVR is comprised of standard removable hard drives run on an embedded platform. It has been 
ruggedized to withstand the vibrations and shock associated with typical transit environments.  
 
The DVR system is capable of supporting up to six user-defined alarm or trigger inputs and two 
outputs. The most common use for such inputs are driver panic buttons and impact sensors. All 
images generated by these inputs are “tagged” with a time and date stamp in order for the critical 
information to be easily found and retrieved.   
 
The DVR recognizes when the maximum available storage capacity for surveillance images has been 
reached and automatically purges the oldest image data in sequence, making room for additional data 
without operator intervention. Images that have been tagged due to activation of an alarm input are 
protected from being overwritten for longer periods of time. The times are keypad programmable. 

 
Retrieval and Viewing of Images 

The Central Station performs two primary functions. By using the WaveReader software, an operator 
may access and review previously recorded images generated by alarm input activation and view 
routine surveillance images. Users who employ the digital cellular transmission option will also be able 
to receive incoming alarms and images from a vehicle and are able to call a vehicle to receive 
“current” images.  
 
This manual is provided for operators of the BusSecure WaveReader software. It is integrated into a 
standard PC running on a Windows® 98/NT/ME/2000/XP platform. To review the stored image data, 
the removable DVR is inserted into the docking station, and using the WaveReader software, images 
can be retrieved and reviewed. Data can then be downloaded locally and/or remotely via ethernet, or 
transferred to alternative mass media for long-term storage. 
 

1.3 PRODUCT DESCRIPTION 

BusSecure WaveReader provides the user the ability to view video via ethernet or modem directly 
from: 

• Digital Video Recorders (DVR). 
• Digital Video Multiplexer Recorders (DVMRe and DVMRe Triplex). 

• Digital Single Channel Recorders (DSR). 
• Digital Video Storage (DVS) devices. 

WaveReader also allows the user to view video that has been archived onto a CD-R, or recorded 
directly onto the hard drive of a PC. 
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1.4 FEATURES 
• Main window for viewing live or recorded video. 
• Disk analysis window provides graphical overview of recorded data on the hard drive. 

• Search Screen window for searching and displaying data from a specific time and date. 
• Event Search window for searching and displaying recorded event data. 
• Video can be downloaded and saved locally using the mvb or 60d file format. 
• Images can be captured, printed, and exported as a bitmap or JPEG file. 

• Images can be enhanced using WaveStudio, as well as while viewing in real time. 
• Extensive Security Features. 
• QuickWave evidence capture CD 
 

 
 

1.5 HARDWARE SYSTEM REQUIREMENTS 
 

Hardware Specification 

CPU Pentium 400 MHz or faster 

RAM 128MB minimum 

Hard Disk Drive 32MB free hard drive space minimum 

Monitor SVGA, 1024 x 768, 24 bit color. 

The following hardware 
system requirements are 
needed before software 
installation. 
Windows® 
98/NT/ME/2000/XP are 
registered trademarks of 
Microsoft Corporation. 

Operating System Windows® 98 Release 2/NT/ME/2000/XP 
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2 GETTING STARTED 

2.1 OPERATOR INFORMATION 
The purpose of this section is to provide the operator with step-by-step instructions to install and run 
BusSecure WaveReader Software. This section covers the basic steps to retrieve, view, print and 
manipulate previously recorded images. Recorded images are accessed through the removable DVR 
and the docking station. Recorded images consist of either recorded surveillance images, or recorded 
alarm-activated events. 

 

2.2 INSTALLATION 
BusSecure WaveReader software must be installed in order to view recorded surveillance images, 
alarm-activated events, and initiate remote sessions. Use the following steps to install the software. 

2.2.1 INSTALLING FROM CD-ROM 
To install the WaveReader on your hard disk from a CD: 
1. Place the WaveReader CD in the CD-ROM drive of the Central Station PC. 
2. Follow the instructions for installation as they appear. 

 
 

If Autorun is not enabled on your PC, choose Run from the Start Menu, then type 
d:\setup.exe (where “d” is the drive letter of your CD-ROM) and click OK. Follow the 
instructions as they appear on your screen. 

 

 
 

2.3 STARTING THE BUSSECURE  WAVEREADER SOFTWARE 
The BusSecure WaveReader software allows users to view and download previously recorded images 
from the DVR. The WaveReader software must be running at all times in order to receive and process 
incoming alarms. The BusSecure Central Station PC should be dedicated only to BusSecure 
applications. 

 

The Central Station PC and all vehicle mounted DVR(s) must be on the same logical 
network and subnet, as well as maintain their own unique IP address. The IP address of 
the DVR(s) is entered during DVR configuration, please refer to the hardware manual 
entitled BusSecure DVR User Manual. Contact your System Administrator for more 
information on the Central Station PC’s IP address and network settings.  

 

 

 

 

To start the BusSecure WaveReader program: 
Double-click on the WaveReader Desktop icon or choose Programs  
from the Start menu and then select WaveReader.  The Main window  
of the WaveReader program will appear. 

NOTE

NOTE



 BusSecure WaveReader User Manual  
  

10 0150-0266B  / March 2004 

 

Icon Bar
Menu Bar

Button Panel

Main Viewing 
Area

 
 

From the Button Bar, click on the Connect button or click on the Connect icon on the icon bar.  The 
Login screen will appear. The default Administrator password is 12345. 

 
 

It is recommended that this password be changed after installation is complete. As a security measure, 
store the password in the administrator’s secure files or in a limited access area.  
 
After a successful login the Setup menu becomes available in the Menu bar and the Address Book 
will appear.  
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The Address Book is a comprehensive relational database consisting of the following fields: 

• Site Description 

• Street Address 
• City 
• State/Province 
• Zip/Postal Code 

• Region/Country 
• IP Address/Phone Number 

• Ethernet/POTS (Connection type) 

• Unit Type (DSR, DVMRe, etc.) 
• Camera Quantity 
• Serial Number 
• Administrator of Unit 

• Contact Phone Number 
• Notes (4 fields) 

 

2.3.1 CONNECTING TO A SITE/DEVICE VIA THE ADDRESS BOOK 
Highlight a selection on the Address Book and double-click or click on the Connect button. 
WaveReader will attempt to connect to the device/site using the parameters specified in the database. 
See Site Administration for information on creating and editing the Address Book. If WaveReader 
cannot connect to the device/site it will display a timeout message. Verify that the parameters in the 
Address Book are correct. If the parameters are correct verify that the PC can connect to the Internet 
or to another ethernet connected device. 

Once connected to the selected DVR, a disk analysis screen will appear and playback of video will 
begin. 
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2.4 RETRIEVING VIDEO FROM A BUSSECURE DVR 
Clicking the left mouse button in the Disk Analysis screen displays a Pop-Up menu with the following 
commands: 

 
• Play 
• Save File (with selected file 

size) 
• Play Cycle 
• Play Event Cycle 
• Protect (with selected file 

size) 
• Unprotect 
• Get Log File 
• Zoom In 
• Cancel  

 

For Details on the Disk Analysis Screen, see Section 3.4. 

To select previously recorded video click and drag (with the left mouse button) over the data bars. As 
you are dragging the mouse two red horizontal bars are displayed that show the start and end of the 
selection. Use the magnifying glass to get a more detailed selection. The Pop-Up menu will display the 
estimated file size of the selected video. Click on the Save File command to bring up the Save an 
Image Sequence dialog box. 

 
 

Click on the Save to File button and the Choose Filename dialog box will appear. 
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Select from two file formats .mvb or .60d. 

• 60d: Use this format for large video clips that have to be downloaded at the fastest speed 
possible or writing to CD via QuickWave. 

• mvb: Use this format for smaller sized video clips. Not for use with QuickWave. 

 

Type in a pertinent filename and click the Save button. 

 

2.5 OPENING A SAVED VIDEO FILE 
Click on File, then Open on the Menu Bar or click the File Open icon on the Icon Bar. Select or 
navigate to the file from the dialog box, and then click the Open button. 

Select from two file formats .mvb or .60d. 

• 60d: This format file does not display the image log and printing is not possible. 

• mvb: This format file does display the image log and printing is an option. 

 
 

The selected file will open and display in the Main Viewing area. The Image Log window will also 
appear (for .60d files only). 



 BusSecure WaveReader User Manual  
  

14 0150-0266B  / March 2004 

 
The Image Log window contains Time Stamp and Camera number information associated with the 
recorded video. Click on an entry in the Image Log to display the video image. Multiple images may be 
selected by clicking on additional entries. Shift-click to select whole blocks of entries. Once selected 
the video images may be played by clicking on the Play Forward button or printed using the Image Log 
Menu. For details on the Image Log see section 3.12. 

2.5.1 PRINTING FROM THE IMAGE LOG WINDOW 
Once selections have been made in the Image Log window, click on the File Menu on the Menu Bar 
(in the Image Log window). 

 
1. Select the Page Layout: Choose Large or Small Images. Large Images are printed 1 per page. 

Small Images are printed 6 per page. 
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2. Select Print Preview to preview the selected images and page layout. Print Preview can display a 
maximum of 150 images. 

 
 

3. Select Print Setup to select a printer, or Print to use the system’s default printer. 
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3 BUSSECURE WAVEREADER REFERENCE 

3.1 WAVEREADER MAIN WINDOW OVERVIEW 
 

Menu Bar
Icon Bar

File Menu

View Menu

Setup Menu

Search Menu

Help Menu

Button 
Panel

Main 
Viewing 
Area

Right-Click on any
Screen to bring up 
Enhancement Menu

Click on any
Screen to force

Single Screen 
mode
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3.2 THE MAIN PROGRAM WINDOW 
The Main program window consists of five areas: 

• The Menu Bar: At the top of the window. 
• The Icon Bar: Underneath the Menu Bar. 

• The Main Viewing Area: The large blue area. 
• The Status Bar: At the bottom of the window. 
• The Button Panel: The left side of the window. 
• The Text Data Display Box: Located under the Main Viewing Area (Not Shown). 

 

3.2.1 THE MENU BAR 
The Menu Bar provides access to the programs functions and parameters, as well as access to files. 
The Menu Bar changes its appearance to reflect the program mode that it is operating in. 

 

Initial Menu

Menu after Log In

Menu after DVR Connection
 

3.2.2 THE ICON BAR 
The Icon Bar provides one-click access to program functions and parameters, as well as access to 
files. 

 

1

2

3

4

7 9 11

12

135

6 8 10
 

 

1. Log In / Log Off  
2. Connect / Disconnect 
3. Open File 
4. Save Image 
5. Print Image 
6. View Live 
7. View Playback 

8. Audio On / Mute 
9. Start / Stop Recording 
10. Go To Time / Date 
11. Advanced Search 
12. Start WaveStudio 
13. Snapshot  
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3.2.3 THE MAIN VIEWING AREA 
Pictures are displayed in this area in Multi-Camera, and Single-Camera formats.  Picture display order 
is according to the information encoded by the unit used to create the original video data file. 
Choose from the following displays: 

• 8-way Multiscreen Display (1 large and 7 smaller images) 
• 4-way Display 
• Single Camera Large 

• Single Camera Medium 
• Single Camera Small 

 

3.2.3.1 ENHANCEMENT POP-UP MENU 
Right-click on any single camera display and the Image Control  
Pop-up menu appears. Select any command to perform the selected  
action on the current image. Once the image enhancements are  
applied, doing a "restore" will not display the original image. This  
"restore" will be applied to future images from that camera. The  
enhancements only affect the way the image is viewed and do not  
affect the actual image itself. 

The following video enhancements are available on this menu: 
• Zoom In and Zoom Out. 
• Contrast 
• Intensity 
• Enhance 
• Sharpen  
• Blur 
• Restore 

 
The option to Mute the Audio if applicable is also featured in this menu. 

 

3.2.4 THE STATUS BAR 
The Status Bar displays messages and current connection status information.  If the user is viewing 
data recorded as files on a CD-ROM or stored on the user’s PC, Path Name information is displayed 
on the status bar. 
Example of the Status Bar showing the path and 
name of the file currently being displayed. 
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3.2.5 THE BUTTON PANEL  

1. Play Backward button: Click on this button to playback video in 
reverse. 

2. Stop button: Click on this button to halt all playback operations. The 
Play Pointer Slider Bar moves to the start of data. 

3. Play Forward button: Click on this button to playback video. 
4. Single Frame Rewind button: Click on this button to rewind the video a 

single frame. 
5. Pause button: Pauses playback until the Pause button is pressed 

again. Clicking any of the buttons, except Stop will also resume 
playback. The Play Pointer slider bar stays at the current position while 
paused. 

6. Single Frame Advance button: Click on this button to advance the 
video a single frame. 

7. Rewind button: Click on this button to perform high-speed reverse 
playback. 

8. Fast Forward button: Click on this button to perform high-speed 
playback. 

9. Connect button: Click on this button to display the address book (after 
a successful login). 

1 2 3

4 6

7 8

9

11

12

14

13

10

5

 
10. Number buttons: Press any of these buttons to call up individual cameras for display.  When      

connected to a DVR buttons 9-16 will be disabled. 
11. Single Camera Display Size: Choose from Small, Medium, or Large. 
12. 8-way and 4-way Multiscreen button: Choose from a Large 4-way or Large 16-way display. 
13. Play Pointer Slider Bar: The Play Pointer slider bar advances to the right to indicate the playback 

position on the disk.  The user can drag the bar to navigate forward or backward. 
14. Play Speed Slider bar: Controls the video playback speed. The default position is to the far right 

and selects the fastest playback speed. Sliding the bar to the far left will set the playback speed to 
approximately one picture per second.   
 

3.3 THE FILE MENU 

3.3.1 OPEN  
From the Menu Bar, click File, then 
click Open or click on the File Open 
icon on the Icon Bar.  The Open 
Wavelet Data Files window will 
appear (depending on the operating 
system, some windows may differ 
from the one shown here). 

1. Select the Drive and the Directory 
(normally the WaveReader directory) 
that contains the video files archived 
from the archiving device. 

2. Select the Filename and click the 
Open button. The default file type is 
the .mvb file. 
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.mvb is the BusSecure  proprietary native file type. These files contain video, audio, and associated 
data information. 
.60d is a Wavelet video clip in a proprietary data format.  Files of this format are created by other GE 
Security digital recorder products. 
.RDB File is a collection of wavelet images in a database. Files of this format are created by other GE 
Security digital recorder products. 
 

3.3.2 SAVE IMAGE 

From the Menu Bar, click File, then 
click Save or click on the Save File 
icon on the Icon Bar.  The following 
menu will appear. 
The benefit to this method is that 
snapshots can be saved with a more 
appropriate file name that better 
describes the picture’s content rather 
than letting the software 
automatically assign a numeric 
sequence file name. 

  
The disadvantage to using this method is that playback operations continue while the user is 
interacting with the dialog box and specifying the file name.  If the user misses seeing portions of the 
video, it will be necessary to replay those sections again so that they may be viewed without further 
distractions. 

3.3.3 PRINT IMAGE 
From the Menu Bar click on File, and then Print Image or click on the Print Image icon on the Icon 
Bar. The Print Image command allows the user to print whatever is displayed in the Main Viewing 
area. Better control over printing is achieved by saving video locally and printing through the Image 
Log. See Image Log in section 3.14. 

3.3.4 LOG IN 
From the Menu Bar click on File, then Log In or click on the Log In icon on the Icon Bar.  The Login 
screen will appear. The default Administrator password is 12345. 

It is recommended that this password be changed after 
installation is complete. As a security measure, store the 
password in the administrator’s secure files or in a limited 
access area.  
 
After a successful login, the Setup menu becomes 
available in the Main Menu bar. 
 

 
 

3.3.5 GET COMPLETE LOG FILE 
From the Menu Bar click on File, then Get Complete Log File. This command retrieves a file used to 
assess the condition of the DVR. Only use this command if requested by GE Security Technical Support. 
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3.3.6 GET LOG FILE 
From the Menu Bar click on File, then Get Log File. This command opens a dialog box in which you 
can specify a start and stop date range for the log file. 

3.3.7 EXIT 
From the Menu Bar click on File, then Exit. This command terminates the BusSecure WaveReader 
program and closes all associated windows. 

 

3.4 THE VIEW MENU 

The View menu is not seen when the program first starts.  It appears only after establishing a Normal 
Connection to a unit on the network, local Ethernet connection, or after opening a Wavelet file with an 
associated header file located in the same directory.  The View menu appears between File and Setup 
menus. 

The following commands are available in the View menu: 

• Disk Analysis Screen: This command displays the Disk Analysis screen. 

• Image Log: This command displays the Image Log screen. 

3.4.1 THE DISK ANALYSIS SCREEN 
The recording dates and times of the file appear above the horizontal bars. 

The light blue vertical marker indicates the 
current play position within the file. 

Horizontal color bars indicate the following: 

Top Row: 

• Green:  Standard Video 
• Red:  Alarm Mode 
Middle Row: 
• Yellow:  Events 
• Black: Not in Event 
Bottom Row: 

• Orange:  Protected or Locked areas 
• Black: Not Protected 

 

Vertical Color cursors indicate the following: 

• Light Blue:  Play indicator, positioned by progress slider bar. 
• Red:  Left and right markers to assist with defining boundaries for data retrieval, etc. Click and Drag 

to the right to place the red cursors in the desired position.   
The Date and Time of the data under the cursor appears near the top of the Disk Analysis Screen. If a 
range is selected, the start and end, time and date of the selected region will be shown. 
Zoom In and Out using the Magnifying Glass, or follow the prompts after clicking on the data bars. 

 
Clicking the left mouse button in the Disk Analysis screen on the data bars displays a Pop-Up menu 
with the following commands: 
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• Play 
• Save File (with selected file 

size) 
• Play Cycle 
• Play Event Cycle 
• Protect (with selected file 

size) 
• Unprotect 
• Get Log File 
• Zoom In 
• Cancel  

 

3.4.2 THE IMAGE LOG 
The Image Log will only appear when an .mvb file is opened. 

The Image Log window contains Time Stamp and Camera number information associated with the 
recorded video.  

Click on an entry in the Image Log to display the video image. Multiple images may be selected by 
clicking on additional entries. Shift-click to select whole blocks of records. Once selected the video 
images may be played by clicking on the Play Forward button or printed using the Image Log Menu. 

(“Selected” records are records in the image log that have the check box checked) 

If no records are selected, all images will be played in a cyclic manner in the multi screen mode. In the 
single screen mode, only images that belong to the selected camera will be played 

If records are selected, only the selection will be played in a cyclic manner. In the single screen mode, 
only images (from the selection) that belong to the selected camera will be played 

Clicking on a record in the log, will cause only that image to be displayed (Not useful when in “Play” 
mode) 

If audio is enabled, images will be dropped to allow for synchronized playback (in all modes) 

Audio is automatically disabled if records are selected 

In the “play” mode, the highlighter bar will indicate the current record that is being displayed 

The slider bar on the wave reader screen can be used to set the “Start” position for playing.  

 

3.4.3 WAYS TO SELECT IMAGES 
• Left button Click, CTRL+ Left button Click - will cause current record to be added to selection. 

• Drag selection, Shift + Click - used to select a block of records. 
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Click to Sort

Clears SelectionsClick to return window 
to original condition

Selected
Images

 

3.5 THE SETUP MENU 
The Setup menu is not enabled when the program first starts.  It is enabled only after a successful 
login.   

 

Setup Menu

Security Menu

Connection Type Menu

MobileView

Audio
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The following menus are disabled once a connection is established between WaveReader and a DVR: 

• The Address Book 
• Connection Type Setup 

• Security 
• BusSecure Configuration Setup 
 

 

3.5.1 THE ADDRESS BOOK 
The Address Book is a comprehensive relational database consisting of the following fields: 

• Site Description 

• Street Address 
• City 
• State/Province 
• Zip/Postal Code 
• Region/Country 

• IP Address/Phone Number 

• Ethernet/POTS (Connection type) 

• Unit Type (DSR, DVMRe, etc.) 
• Camera Quantity 
• Serial Number 
• Administrator of Unit 
• Contact Phone Number 

• Notes (4 fields) 
 

 

 
 

 

The lower portion of the Address Book contains groups of command buttons. See illustration above. 

Use the Column/ Search fields to perform searches by category and keyword. 

Use the Export button to send the Address Book data into one of or all the following filetypes:  

• A Delimited File 

• An HTML File 

• An Excel File 

Use the Print button to send the Address Book data to the default printer in a spreadsheet-like format. 

 

3.5.1.1 CONNECTING TO A SITE/DEVICE VIA THE ADDRESS BOOK 
Highlight a selection on the Address Book and double-click or click on the Connect button. 
WaveReader will attempt to connect to the device/site using the parameters specified in the database. 
See Site Administration for information on creating and editing the Address Book. If WaveReader 
cannot connect to the device/site it will display a timeout message. Verify that the parameters in the 
Address Book are correct. If the parameters are correct verify that the PC can connect to the Internet 
or to another ethernet connected device. 
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3.5.1.2 EDITING THE ADDRESS BOOK 

To edit the Address Book, click on the Edit button. The  
Site edit window will appear. This window allows the user 
to: 

• Add new device/site information. Clicking 
on Add also provides the option of  
importing an Address Book that has been  
saved as a .lst file from a previous version  
of WaveReader 

• Edit existing records. 
• Delete existing records. 
• Search through current records by the 

Site Description, IP/Phone Number,  
Street, City, State/Province, Zip/Postal  
Code, or Region/Country fields. 

 
The required fields in this dialog box are bolded. 
 

3.6 THE SECURITY MENUS 
 

3.6.1 SECURITY SHELL OVERVIEW 

The Security Shell is designed to provide controlled access to multiple Digital Recorder units by 
multiple users. The following definitions are used in the discussion below: 
 

• User:  A person that uses the WaveReader to review data stored on a Digital Video Recorder (DVR). 
• Group:  A collection of Users that have specific access rights to a specific list of Sites. 
• Site:  A specific Digital recorder with a unique IP address. 

 
Users are assigned to specific Groups. Any number of Groups can be defined. Every user can only 
belong to one Group. The default Group is called the Administrator group and cannot be deleted from 
the database. Users that are assigned to the Administrator Group have full access rights to all Sites in 
the Database. The Administrator is the default user in the Administrator group. Examples of Groups 
names would be: Management, Engineering, Supervisor and Shipping. 
 
Only Users who belong to the Administrator Group have access to all administrative functions – all 
other users are only allowed to change their own passwords and to view their user rights. 
 
All groups except the Administrator group have specific sites that are associated with them. Every Site 
in the database can be associated with any number of Groups. A Group also has access rights that 
can be set up that apply to all Sites in the Group. A Supervisor Group, for example, might have the 
right to delete files on all Sites associated with the group. 
 
A Group may also be set up to have unique access rights on a per Site basis. The administrator can 
specify for each site belonging to the group, whether WaveStudio can be used to enhance and 
analyze images, or whether clips from the unit can be saved on the PC. 

1  Recordst Last Record
Previous Record Next Record
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3.6.1.1 USING THE SECURITY DATABASE FROM MULTIPLE COMPUTERS. 

When WaveReader has been installed on several networked computers, it is possible to use only one 
central database that can easily be maintained by the Administrator.  
 
During the installation of WaveReader on a clean Computer, the Security Database is copied to the 
WaveReader folder. The filename is WRSecurity.mdb. This file can be moved to a drive on the 
network that can be accessed from the PC. The WaveReader then has to be instructed where the 
database is located. This is done as follows: 
 

Using any ASCII editor like Notepad, open the file BWVAL.DAT that is located in the 
WaveReader folder. Edit or add the following line to reflect the new position of the database on 
the network: (The part following the ‘=’ is the network path of the WRSecurity.mdb file). 
 
SECURITY_DB_PATH_AND_FILENAME = P:\Security\WRSecurity.mdb 

 
Be sure to remove the letters “REM” that may come before the string. The next time WaveReader is 
launched it will get its Security settings from the network database. Several WaveReaders can be set 
up this way to simultaneously access the same database file. 
 
If the WRSecurity.mdb file is not moved to the network, each WaveReader will simply access the 
database on its local hard drive and the site and user information will have to be added to every 
database individually. 
 

3.6.1.2 ADDITIONAL NOTES. 

It is recommended that the Administrator always add at least 1 user beside himself to the 
Administrator group. If he forgets his password, the other user can still log in and reset the 
Administrator’s password. If all users in the Administrator group forget their passwords, they would 
have to contact GE Security Technical Support to have their passwords reset. 
 
Uninstalling WaveReader from a PC will not remove the BWVAL.DAT file or the WRSecurity.mdb 
database file from the WaveReader folder. When the new WaveReader is installed, a user will be able 
to log into the old database without any additional setup. 
 
On PC’s that have both WaveReader and WaveWatch installed it is necessary to uninstall both 
programs when upgrading to a new WaveReader. This is because some system files are shared by 
the two applications and will cause problems with the new installation if not properly removed. 
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3.7 SECURITY MENUS 
WaveReader features extensive security and 
administrative options. From the Menu Bar click 
Setup, then Security. The following options are 
available: 

• Change Password 
• View User Rights 
• Site Administration 
• Group Administration 
• User Administration 
• Unit Type Setup 
• Custom Caption Setup 

 

3.7.1 CHANGE PASSWORD 

By default, the password for User 1 (Administrator) is 12345 when the software is first installed. It is 
recommended that this password be changed after installation is complete.  After the Administrator 
creates new user groups and new users, all the users will be able to set and change their individual 
passwords. As a security measure, store the password(s) in the administrators secure files or in a 
limited access area. 

 
 

To change the Password, select Setup à Security à 
Change Password from the menu bar. The Change 
Password dialog box will appear. 
• Click in the box labeled New Password. 

• Type in the new password. 
• Click in the box labeled Confirm Password. 

• Type in the new password again.  

• To complete the selection, click the OK button. If the new password was accepted the Password 
Accepted box will be displayed. 

• If the Cancel button is chosen, the password will not be changed. 
 

3.7.2 VIEW USER RIGHTS 
To View User Rights, select Setup à Security à View User Rights from the menu bar. The Group’s 
Rights window will be displayed. This window provides a quick overview of User and Group rights that 
have been setup in the Group Administration database. No editing functions may be performed in 
this window.  
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3.7.3 SITE ADMINISTRATION 

Site Administration provides all the data required for the creation of the Address Book. To access Site 
Administration, select Setup à Security à Site Administration from the menu bar. The Sites Edit 
window will be displayed. 

3.7.3.1 CREATING THE SITE ADDRESS BOOK 
This window allows the user to: 

• Add new device/site information. Required  
fields are Bolded. Clicking 
on Add also provides the option of  
importing an Address Book that has been  
saved as a .lst file from a previous version  
of WaveReader 

• Edit existing records. 
• Delete existing records. 
• Search through current records by the 

Site Description, IP/Phone Number,  
Street, City, State/Province, Zip/Postal  
Code, or Region/Country fields. 

 
 
 

3.7.3.2 IMPORTING AN ADDRESS BOOK (FROM VERSIONS OF WAVEREADER EARLIER THAN 2.5) 
Click on the ADD button in the Sites window. This modifies the button bar on the bottom of the window 
to include an Import Sites button. Follow the steps below to import the Address Book. 

1. Click on the Import Sites Button. This  
brings up the Import Sites windows.  

2. Click Import Sites from Address Book File. 
This brings up the Open List File window. 

3. Navigate to the folder in which the .lst file  
resides.  

NOTE: A .lst file may be created using any text  
editor such as Notepad.  See the section titled  
Creating an Address File on the following pages. 

4. Select the .lst file and click Open. This places  
the address list in the Import Sites window. 

5. Click Add all Selected Sites to the Database.  

 

 

1  Recordst Last Record
Previous Record Next Record
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3.7.3.3 CREATING AN ADDRESS FILE (FOR BASIC INFORMATION) 
The Address Book file may be created using any text edit such as Notepad.  A sample address book 
may look like the following. Be sure to save or rename the file with the extension, .lst. Once created 
the user can import the file using the previous procedure. 

The first line (1000): Indicates a version number used by 
WaveReader to identify this list.  Do not edit this number. 

The second line (3): Indicates the number of addresses 
in the list.  Change this number only if the number of 
address in the list changes. 

1000 
3 
0,"10.90.253.129","Alex's unit","12345" 
0,"10.90.10.110","demo room","54321" 
0,"10.90.253.28","Test unit","" 

 
The address line indicates the following 4 items: 

• This unit is connected via ethernet (indicated with a 0), or this unit is connected via a modem 
(indicated with a 1). 

• The IP address or telephone number of the remote unit (example IP address show above 
"10.90.253.129") 

• The name given to the remote unit (Example: “Alex’s unit”) 

• The password for connecting to the remote unit (Example: “12345”).  This field is not always 
populated. 

 
 

3.7.4 GROUP ADMINISTRATION 
Group Administration provides all the parameters required to set up various Group rights and access 
levels. To access Group Administration, select Setup à Security à Group Administration from the 
menu bar. The Groups Edit window will be displayed. 

This window allows the user to: 

• Add new Groups, set their 
Access Level and 
Connection Type. Set their 
Group Rights and the Sites 
they have access to. 

• Edit existing records. 
Clicking in the Edit button 
adds a Show Users and 
Add All Sites Button on the 
Button Bar. The Show Users 
button displays all users in 
the currently selected group. 
The Add All Sites button will 
add all available Sites to the 
selected group. 

• Delete existing records. 
• Search through current 

records by Group Name, 
Access Level and 
Connection Type fields. 
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3.7.4.1 ACCESS LEVELS  

The Access Levels are priority ratings used by the unit to determine if a currently established 
connection should terminate when a user with a higher priority level requests a connection. 
If the current user has a lower access level, the unit will break its connection after sending a message 
to the users PC indicating that their connection has been terminated. 
The status bar at the bottom of the WaveReader main window will also indicate that the unit 
terminated the connection. 
There are three levels of access that can be set up in WaveReader: 

• 1 (lowest) 
• 2 

• 3 (highest) 
 

3.7.5 USER ADMINISTRATION 
User Administration provides all the data required for adding Users and user information into various 
Groups. The users will have the rights and access levels of the group to which they are assigned. 

To access User Administration, select Setup 
à Security à User Administration from the 
menu bar. The Users Edit window will be 
displayed. 

This window allows the user to: 

• Add new users. 
• Edit existing users. 
• Delete existing users. 

 
• Search through current records by User Name, Phone Number, Email Address, 

and Group Name. 
 

3.7.6 UNIT TYPE SETUP 
Unit Type Setup provides the data required for Unit Type field in the Site Administration window. To 
access Unit Type Setup, select Setup à Security à Unit Type Setup from the menu bar. The Unit 
Type Edit window will be displayed. 
This window allows the user to: 

• Add new devices. 
• Edit existing devices. 
• Delete existing devices. 

 
 

3.7.7 CUSTOM CAPTION SETUP 
The Custom Caption Setup menu allows the user to change the 4 provided Notes fields into user 
labelled fields. To access the Custom Caption Setup, select Setup à Security à Custom Caption 
Setup from the menu bar. The Custom Caption Setup Edit window will be displayed. 
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To relabel a field name simply highlight the 
current label, type in the new designation and 
click on the Update button. 

 
 

 

3.8 CONNECTION TYPE SETUP MENU 
Two types of Ethernet connections 
can be established between the 
WaveReader software and a unit. 
• Normal Connection 
• Live Connection 

 

3.8.1 NORMAL CONNECTIONS 

When a Normal Connection is made, the user may select between two operating modes: 
• Playback Mode: Allows the user to view and search recorded data from the units hard disk. 

• Live Mode: Allows the user to view live images. 
 

3.8.1.1 PLAYBACK MODE 

Once a connection has been made, pressing the Play button on the button panel causes images to be 
received and displayed.  Within a few seconds the Disk analysis window (see Section 3.4.1) is also 
displayed in this mode.  Playback is the default mode. 
 

3.8.1.2 LIVE MODE 

When viewing live images from the vehicle mounted DVR, 
the software may be switched to the Live Look-in mode via 
the Setup menu. 
This mode does not apply to a DVR in a docking station, 
where there are no cameras connected. 
The View Live command is added to the Setup Menu only 
after a Normal Connection has been established.  Along 
with the images being displayed, the current Date, Time 
and Alarm status of the unit are also shown. 
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3.8.1.3 ENTERING THE LIVE MODE 
To enter Live Mode, select Setup à View Live from the menu bar. 

To begin viewing live images: 

• Click the Play button.  The Play button will turn green to indicate that it has been selected. 

• The Pause button functions as Stop button. 

• The Pause, Disconnect, Multi-Camera, Camera Size, and Camera buttons are black and remain 
active. The remaining buttons turn gray and are inactive. 

• The View Live command is replaced with the View Playback command. 
• The current Date and Time appears. 
• Multi-Camera live images can be viewed in an 8-Way or 4-way format. 
• Single Camera live images can be viewed in Large, Medium, or Small formats. 
• Clicking any camera image will display that camera image in full screen. 
• A red letter "A" opposite the camera number means an alarm for that camera. The Alarm 

indicator (the red A) will be preceded and followed by a red letter “P” which indicates the Pre- 
and Post- Alarm periods. 

 

3.8.1.4 LEAVING LIVE MODE 

To leave Live Mode, select Setup à View Playback from the 
menu bar. 

• Live images for each camera stop updating. 
• All buttons return to black. 
• The View Live command is replaced with the View 

Live command. 
• WaveReader is still connected to the unit. 

 

3.8.2 LIVE CONNECTIONS 

When a Live Connection is made to a vehicle mounted 
DVR, the user is limited to viewing live images only.   
This mode does not apply to a DVR in a docking station, 
where there are no cameras connected. 
The user can establish a Live Connection even if a 
different user has established a Normal Connection. 

 

To establish a Live Connection, select Setup à Connection Type Setup à Live Connection from 
the menu bar. 
No disk analysis screen is displayed. 

To begin viewing live images: 

• Click the Play button.  The Play button will turn green to indicate that it has been selected. 

• The Pause button functions as Stop button. 

• The Pause, Disconnect, Number, Multiscreen and Camera Size buttons are black and remain 
active.  The remaining buttons turn gray and are inactive. 

• The current Time and Date appear. 

• Multi-Camera live images can be viewed in an 8-Way or 4-way format. 
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• Single Camera live images can be viewed in Large, Medium, or Small formats. 

• Clicking any camera image will display that camera image in whatever format was last selected 
for viewing individual cameras. 

• A red letter "A" opposite the camera number means an alarm for that camera. The Alarm 
indicator (the red A) will be preceded and followed by a red letter “P” which indicates the Pre- 
and Post- Alarm periods. 

 
 

 

3.9 BUSSECURE MENUS  
The BusSecure Setup menu options 
can be accessed through the Setup 
menu.  
  

 

3.9.1 VERSION INFO 

To access Version Info command, 
select Setup à BusSecure à 
Version Info from the menu bar. The 
Version Info command displays a 
window with the Serial Number, Disk 
Capacity and Software version 
numbers for all programmable devices. 
  

 

3.9.2 CONFIGURATION SETUP 
To access Configuration Setup screen, select Setup à BusSecure à Configuration Setup from the 
menu bar. The following window will appear. 
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Check to use MV3
Style Address Book

Check to Start Recording 
at unit connection

Event and Alarm File Paths

Event File Name

Navigation Buttons

Click to Remove 
or Add Specific
Actions to Action
List

Defined Actions 
in Action List

File Name and Path where 
the Action List text file is
stored

Use this field to specify 
the application to use to 

retrieve the Log File. 
(Default is Notepad)

Use this field to add an 
Action to the Action List

Click the Add button to insert
 

3.9.2.1 AUTO RECORD AFTER CONNECT 
If this box is checked, WaveReader will record every image that is viewed from a unit it connects to. 
The recording is saved in the mv3.mvb file when viewing in the docking station. 

3.9.2.2 USE MV ADDRESS LIST 
If this box is checked, WaveReader will give preference to the short address book, automatically 
detected from broadcasting stations on the LAN. This takes preference over the comprehensive 
address book provided for users who wish to connect to a wide variety of DVR’s. 

3.9.2.3 THE ACTION LIST 
The Action List (WaveReaderactions.txt) is used for the placement and designation of actions to be 
performed by the Central Station operator when an alarm is received: 

The Action List field designates the folder that the actions will be stored in. It is recommended that this 
folder remain at its default location. 

This window is also where the Actions are defined and entered. Defining and adding actions should be 
done at the beginning of the Central Station Software setup. Place the cursor in the bottom screen and 
enter the name of an action and click on Add. Repeat for every action you wish to be displayed on the 
Alarm transmission drop down menu on the BusSecure Alarm screen.  

To remove an action, highlight the action with the mouse and click on the Remove button. 

The Action List will appear on the alarm drop-down menu of the BusSecure alarm screen when an 
alarm is received.  

The Central Station Operator can then click on the actions taken in response to that alarm, and those 
actions will become a part of the event record. 

 

3.9.3 AUDIO MENU 
To access Audio commands, select Setup à BusSecure à Audio from the menu bar. The Operator can 
Mute or Play the audio from this menu. 
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When playing directly from disk, audio is only available when looking at a camera full screen. However all 
audio associated with the time period being viewed, is stored in the *.mvb file. When downloading a video 
clip from disk, all audio for the time period selected, is also saved to the *.mvb file.  
When playing back from an *.mvb file, operation is different. When audio is on, synchronized video is 
played with the audio. This means that images might be dropped so that the audio is not interrupted. This 
is especially true when playing back in multiscreen. In order to see all the captured frames, audio can be 
turned off.  
When individual images are selected in the image log for playback, audio is automatically disabled. Audio 
is also automatically disabled when playing backwards, rewinding or fast-forwarding. 
 

3.10 THE SEARCH MENU 
Once a Normal Connection has been established between the PC and a unit, the Search Menu option will 
appear in the Menu Bar and the Search Icon will become available in the Icon Bar.  

 

Launch the Search screen by clicking on the Search icon  or the Search menu option. The Search 
Screen has two modes basic and advanced.  The Search screen is in basic mode when it first appears 
as shown below. 

 

 

3.10.1 BASIC MODE 
In basic mode, the user can set up the Date and Camera filters. Selecting any of these parameters 
modifies the Search Filters screen and displays that selection’s options. The screen below shows the 
Search Screen with both of these filters selected. 
 

 
 



 BusSecure WaveReader User Manual  
  

36 0150-0266B  / March 2004 

The Search Filters Menu bar contains the File and Setup menus. 

The File menu contains the Load Search Filters menu and the Save Search Filters menu. Search filter 
combinations can be saved and loaded through these menus for use on different devices. Filter 
parameters in the saved file that are not applicable on a particular device are ignored during the Search. 
Search filter parameters are saved in xml format in the Quickwave directory. 

The Setup menu contains the Mode menu. 

The Mode menu is used to select the way the search is reported, Batch or the default Interactive. The 
batch mode does not have any result quantity limitation and all results are written to a file. The file format 
choices are txt, html, or xml. 

The Go To button in the Date filer section begins transmitting recorded video from the closest point to the 
time and date selected. If the unit is not currently playing back video when the Go To button is clicked, 
the user will have to click the Play button on the button panel to start playback. 
 
Clicking on the Advanced button will expand the Search Filters screen to include filters such as 
Alarm/Event and Text. The screen shown below is shown with the Text tab selected. 
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3.10.2 ADVANCED MODE 
In the advanced mode, the user can specify alarm/event and text filters in addition to camera, date and 
week. If the user is not logged in or doesn’t have rights to do an advanced search, the user cannot switch 
to advanced mode. The advanced button will be grayed out. 
 
The Alarm/Event tab executes searches based upon Alarm or Event flags. 
 
The Text tab allows the user to type in text and search for it.  
 
Click on the Search button to execute the search. 

 

3.10.3 SEARCH RESULTS 
After the Start Search button is pressed, 
the unit will search for the specified 
events.  After a short time, the Event 
Search Results window will appear. 
The Event Search Results window 
displays the: 

• Start and Stop Time/Date. 
• The Camera Number. 

• The type of information 
(Alarm, Event, Normal, 
Motion). 

• The Text Data.   

When searching event/alarm data, the input name(s) of the input(s) that resulted in the event/alarm, 
will be displayed in the text data area. 

This window will display a maximum of 10 items.  To view additional items, click the Next or Previous 
buttons.  Clicking directly on a line item will cause that item to be displayed on the main screen. 

 

3.11 THE HELP MENU 
The Help menu options can be accessed through the main menu bar. To access the Help menus, 
select Help from the menu bar. 

 

3.11.1 HELP TOPICS 

The Help Topics are available in this menu and for specific help on some options, Depress the F1 key 
while the mouse is hovering over a feature. 
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3.11.2 ABOUT  

The About command provides 
information about the Version number 
of the Software. 
Access to the Windows System Info 
command is also available in this 
window. Extensive System information 
can be retrieved with this command. 
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4 WAVESTUDIO 
WaveStudio is an image enhancement program designed specifically for use with WaveReader.  
WaveStudio allows the user to capture and save images.  WaveStudio also allows the user to increase 
or decrease contrast, zoom, sharpen lines, enhance sections of the picture, and bring out detail in dark 
areas. 

4.1 OPENING WAVESTUDIO 

From the Menu bar, select File à Start WaveStudio.  The WaveStudio window will open.  The 
WaveStudio window consists of two areas, the Main Viewing Area, and the Toolbar. 

 

4.2 WAVESTUDIO TOOLBAR  
All of the functions in WaveStudio are performed using the toolbar located on the left side of the 
WaveStudio window. 

Intensity:  Changes the overall brightness (intensity) of the image. 
Contrast:  Increases or decreases the contrast of the image. 
H. Contrast:  Increases or decreases the contrast of the image, using a 
histogram to determine the median brightness. 
This method finds the median brightness of the image; then brightens the pixels 
with values above the median and darkens the pixels with values below the 
median.  This is more sophisticated (but slower) than the regular contrast 
method, which uses the middle possible value (128) rather than finding the 
actual median. 
Hue:  Changes the hue of colors in the image by rotating the color wheel.  The 
user can rotate the color wheel in either direction.  A 180-degree rotation in 
either direction changes each color to its complement.  Positive rotation takes 
red toward green, green toward blue, and blue toward red. Negative rotation 
has the opposite effect. 
Saturation:  Negative values decrease the saturation of colors.  Positive values 
increase the saturation.  The saturation level is increased or decreased by a 
percentage of its present saturation level. 
Sharpen:  Increases or decreases the sharpness of the image.  Negative 
values decrease the sharpness of the image.  Specify –1000 for minimum 
sharpness.  Positive values increase the sharpness.  Specify +1000 for 
maximun sharpness. 
Zoom:  Clicking the In or Out button will cause the image to begin increasing or 
decreasing in size.  Click the Stop button to stop the zooming.  Click the Normal 
button to return the image to the original size. 
Noise Removal:  Changes the color of each pixel in the image to the average 
color of the pixels surrounding it.  This results in a blur effect. 

 

Histogram Equalization:  Linearizes the number of pixels per gray area in the image.  This can be 
used to bring out detail in the dark areas of an image. 

Region Selection:  Used to isolate sections of an image for enhancement.  Select Rectangular to 
drag a box over the desired picture area.  Select Freehand to draw borders around the desired area.  
Click On to activate this feature. 
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Copy & Paste:  Use these buttons to copy images to or from the clipboard. 

Undo:  Click this button to undo all changes made to the image. 

Done:  Click on this button to close the WaveStudio program. 

4.3 WAVESTUDIO MAIN VIEWING AREA 
When WaveStudio is 
opened, it automatically 
captures the image 
currently displayed in the 
WaveReader Main Viewing 
Area. 
Use the WaveReader 
window to find and pause 
the exact image you wish to 
edit. 
Press the Load button to 
insert the image into the 
Wavestudio’s Main Viewing 
Area. 
Any image size or screen 
configuration displayed in 
the WaveReader Main 
Viewing Area can be copied 
to the WaveStudio Main 
Viewing Area. 

 

 

4.4 OPENING A FILE IN WAVESTUDIO 
To open a file in WaveStudio, select File à Open from the Menu bar. The open file dialog window will 
appear. Navigate to the file to edit, select the file and click open. 

 
 

WaveStudio can open images in .bmp and .jpg formats. 
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5 QUICKWAVE EVIDENCE CAPTURE CD 
WaveReader allows any PC user with a CD writer to create a portable evidence CD, which includes an 
auto-launching lite version of WaveReader called QuickWave.  WaveReader does not need to be 
installed on the PC for QuickWave to operate, and QuickWave does not install itself (or a version of 
WaveReader) on the PC upon which it is being played-back.  The program is loaded and played 
directly from the QuickWave CD. 

The QuickWave CD cannot be played back on Windows 95 or Windows 98 Release Version 1. 

5.1 CREATING THE QUICKWAVE CD 
1. Use the Disk Analysis Screen in WaveReader to select and save the desired video data as a .60d 

file. 
2. Copy the .60d file (or files) to the C:\Program Files\WaveReader\QuickWaveCD\QuickWave folder. 
3. Using the CD writer software, select the contents of the C:\Program 

Files\WaveReader\QuickWaveCD folder. 
 

Do not select the QuickWaveCD folder to be written by the CD writer.  Select the 
contents of the QuickWaveCD folder to be written by the CD writer. 

 
4. Using the CD writer, create the QuickWave CD. 
5. Test the CD by placing it in the CD drive of your computer.  The QuickWave program should 

launch automatically, and begin playing the .60d file. 
 

When finished creating the QuickWave CD, delete the .60d file (or files) from the 
C:\Program Files\WaveReader\QuickWaveCD\QuickWave folder, so that it does not 
accidentally get copied onto a QuickWave CD (for which it was not intended) in the future. 

5.2 PLAYING THE QUICKWAVE CD 
1. Place the QuickWave CD in the CD drive of a PC. 
2. The QuickWave program will launch from the CD and begin playing the .60d file. 
3. QuickWave’s operation is similar to that of WaveReader. 
4. Select File à Open to playback a different .60d file. 
 

NOTE

NOTE
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WARRANTY AND RETURN INFORMATION 

GE Security warrants all of its equipment for three years from the date of purchase. This warranty covers 
any defects in materials and workmanship. Equipment failures that are due to improper installation, 
modification, abuse, or acts of nature will not be covered by this warranty. The repair department will 
evaluate all equipment returned for repair to determine warranty coverage. The Tech Support Manager 
will resolve any questions that may arise during evaluation to make a final determination. 

Note: The three-year warranty does not apply to the following products: 
BusSecure® and the monitor CRT, which carry a 12-month warranty from the date of purchase. 

The warranty specifically covers any defects in material and workmanship and does not cover equipment 
that has been abused, damaged, or modified. 

For all warranty repairs, GE Security will cover all costs, including parts, labor, and shipping. Repaired 
equipment will be returned via the same method of shipment in which it was received. If a customer 
requests a faster return shipment, the difference will be charged. 

For all non-warranty repairs, the customer will be billed for parts, labor, and shipping. Labor will be 
billed in half-hour increments.  

Note: Customers requesting an estimate prior to repair will be notified by phone. If they cannot be reached, they will be notified by 
fax. If we are unable to reach the contact person for repair authorization after one phone attempt and two fax attempts, the 
equipment will be returned without being repaired. We will hold equipment no longer than two weeks. 

ADVANCE REPLACEMENT POLICY 

When an advance replacement is required, we will send the customer replacement equipment from our 
stock and receive the returned product in exchange. The received equipment will be evaluated and the 
repair department will determine whether it is a warranty replacement. If it is non-warranty, see our repair 
policy above for details. The following guidelines will be used for all advance replacements: 

� Fewer than 45 days from purchase, GE Security will replace the product with new equipment. 

� From 45 days to 1 year from purchase, GE Security will replace the product with refurbished 
equipment. 

� From 1 year to 3 years from purchase, the product must be sent in for repair. Advance 
replacements will be sent for a fee of $100. 

If you have questions about this policy, please contact GE Security’s RMA department at 
800-469-1676. 


